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	Verzia
	Autor(i)
	Dátum
	Sumár zmien

	0.1
	Jaroslav Porubän
	
	Úvodná verzia.

	0.2
	Michaela Bačíková
	
	Doplnenie opisu jednotlivých krokov.

	0.3
	Jaroslav Porubän
	
	Oprava a doplnenie textov.

	0.4
	Michaela Bačíková
	
	Doplnenie opisu elementov.

	0.5
	Michaela Bačíková
	
	Doplnenie časti „Pokročilá práca 
s projektom“.

	0.6
	Jaroslav Porubän
	
	Oprava a doplnenie textov.

	0.7
	Michaela Bačíková
	
	Doplnenie opisu elementu <math>, drobné úpravy.

	0.8
	Michaela Bačíková
	5.10.2013
	Doplnenie opisu elementu <solution> podľa upravenej implementácie.

	0.9
	Michaela Bačíková
	17.10.2013
	Doplnenie časti „Zaheslovanie prístupu k učiteľským materiálom“ a časti „Vygenerované súbory“.

	1.0
	Michaela Bačíková
	21.10.2013
	Doplnenie atribútu size pre elementy image. Oprava chybného opisu elementu link.

	1.1
	Michaela Bačíková
	26.10.2013
	Úprava návodu pre zaheslovanie učiteľských materiálov.

	1.2
	Michaela Bačíková
	30.10.2013
	Úprava opisu elementov <solution> a <result> na základe zmien v kóde. Teraz moze v ulohe byt aj solution aj result.

	1.3
	Sergej Chodarev
Michaela Bačíková
	20.11.2013
	Doplnenie opisu elementu <code>.
Doplnenie opisu elementu <table>.

	1.4
	Michaela Bačíková
	03.12.2013
	Doplnenie návodu pre použitie prídavného modulu.

	
	
	
	Doplnenie návodu o opis štruktúry xml opisujúceho úvodnú stránku predmetu.

	
	
	
	Doplnenie opisu elementu objective.

	1.5
	Michaela Bačíková
	04.12.2013
	Oprava, doplnenie textov.

	1.6
	Sergej Chodarev
	10.02.2014
	Doplnenie návodu o opis elementu quiz.

	1.7
	Sergej Chodarev
	12.02.2014
	Aktualizácia opisu elementu quiz.

	1.8
	Michaela Bačíková
	03.09.2014
	Pridanie návodu pre vypnutie kontroly HTML elementov.
Doplnenie opisu elementu link a elementov task, step a resource kvôli pridávaniu podpory referencovania HTML odkazov na sekcie v texte.
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1. [bookmark: _Toc397514625]Inštalácia editora
Pre vytváranie učebných materiálov je potrebné si stiahnuť editor NetBeans IDE nakonfigurovaný pre XML z:
https://bodrog.fei.tuke.sk/it4kt/PORADY/A31_porady/20121130/netbeans.zip
Tento editor je zatiaľ možné používať len na operačnom systéme Windows.
Po stiahnutí je potrebné súbor rozbaliť pomocou komprimačného programu (napr. WinZip, WinRar, Total Commander).
Po rozbalení je potrebné spustiť dvojklikom súbor „netbeans.bat“ v adresári „netbeans“. Zobrazí sa inštalačný dialóg. Je potrebné vykonať nasledujúce kroky:
· akceptovať licenciu programu NetBeans IDE prostredníctvom „I Accept“,
· ak ste predtým mali nainštalovanú inú verziu NetBeans IDE, potvrďte importovanie nastavení pomocou tlačidla „Yes“,
· spustí sa editor NetBeans IDE.
Spustenie editora NetBeans IDE je odteraz možné pomocou dvojkliku na súbor „netbeans.bat“.
2. [bookmark: _Toc397514626]Stiahnutie projektu z SVN repozitára
Na to, aby bolo možné vytvárať učebné materiály, je potrebné stiahnuť projekt pre vytváranie materiálov zo Subversion repozitára.
V menu NetBeans IDE vyberte „Team -> Subversion -> Checkout...“.
[image: C:\checkout1.png]
Zobrazí sa dialóg „Checkout“.
· Do poľa „Repository URL“ zadajte URL odkaz na repozitár projektu:
http://svn.it4kt.cnl.sk/cvicenia
· do poľa „User“ zadajte login do projektu IT4KT: it4kt,
· do poľa „Password“ zadajte heslo do projektu IT4KT: Pr0j5KT,
· zaškrtnite políčko „Save Username and Password“,
· kliknite na tlačidlo „Next“.
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V časti “Folders to Checkout” vyberte adresár repozitára, ktorý sa má stiahnuť prostredníctvom tlačidla “Browse…” v časti “Repository Folder(s)”.
[image: C:\checkout3.png]
Vyberte adresár “it4kt_practices” a stlačte “OK”.
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Stlačte tlačidlo „Finish“.
[image: C:\checkout3.png]
NetBeans následne stiahne projekt z repozitára SVN. Po stiahnutí sa objaví dialóg pre otvorenie projektu. Stlačte tlačidlo “Open Project”. Po kliknutí uvidíte v časti “Projects” projekt IT4KT Practices.
[image: C:\checkout5.png]
1. [bookmark: _Toc341998674][bookmark: _Toc341998927][bookmark: _Toc342004127][bookmark: _Toc342004610][bookmark: _Toc342004651][bookmark: _Toc342030855][bookmark: _Toc343538353][bookmark: _Toc343538408][bookmark: _Toc343538537][bookmark: _Toc367199628][bookmark: _Toc372704131][bookmark: _Toc373869179][bookmark: _Toc373870300][bookmark: _Toc373871366][bookmark: _Toc373933423][bookmark: _Toc379787603][bookmark: _Toc379957089][bookmark: _Toc397507630][bookmark: _Toc397514532][bookmark: _Toc397514627]
2. [bookmark: _Toc343538538][bookmark: _Toc367199629][bookmark: _Toc372704132][bookmark: _Toc373869180][bookmark: _Toc373870301][bookmark: _Toc373871367][bookmark: _Toc373933424][bookmark: _Toc379787604][bookmark: _Toc379957090][bookmark: _Toc397507631][bookmark: _Toc397514533][bookmark: _Toc397514628]
2.1. [bookmark: _Toc397514629]Nastavenie zobrazenia adresárov v editore
Pre správne zobrazenie adresárovej štruktúry je ešte potrebné v editore zmeniť zobrazenie adresárov. Klikne pravým tlačidlom na voľné (biele) miesto v časti „Projects“ a v kontextovom menu vyberte voľbu „View Java Packages as –> Tree“.
[image: C:\checkout6.png]

2.2. [bookmark: _Toc397514630]Aktualizácia projektu – vždy pred prácou!
DOLEŽITÉ: Keďže v tomto projekte bude pracovať viacero ľudí, je nutné pred každou prácou na projekte aktualizovať projekt!
To je možné nasledovne. Kliknite pravým tlačidlom myši na koreňový adresár projektu IT4KT Practices. V kontextovom menu vyberte „Subversion -> Update”.
Ak by po alebo počas procesu aktualizácie projektu nastali akékoľvek problémy, ihneď kontaktujte správcov projektu!
[image: C:\update1.png]
2.3. [bookmark: _Odoslanie_materiálov_predmetu][bookmark: _Toc397514631]Odoslanie materiálov predmetu na SVN
Aby ste mohli publikovať svoj materiály pre svoj predmet, musíte ho odoslať na SVN repozitár.
To je možné nasledovne. Kliknite pravým tlačidlom myši na adresár vášho predmetu, v ktorom sa nachádzajú materiály. V kontextovom menu vyberte „Subversion -> Commit”.
DOLEŽITÉ: Keďže v tomto projekte bude pracovať viacero ľudí, je nutné aby ste odosielali IBA adresár SVOJHO predmetu, inak môžu nastať na serveri konflikty a môžete narušiť štruktúru svojho alebo cudzieho predmetu!

[image: C:\commit1.png]
3. [bookmark: _Toc397514632]Štruktúra projektu a práca s IDE
1. [bookmark: _Toc342004134][bookmark: _Toc342004617][bookmark: _Toc342004658][bookmark: _Toc342030862][bookmark: _Toc343538360][bookmark: _Toc343538415][bookmark: _Toc343538543][bookmark: _Toc367199634][bookmark: _Toc372704137][bookmark: _Toc373869185][bookmark: _Toc373870306][bookmark: _Toc373871372][bookmark: _Toc373933429][bookmark: _Toc379787609][bookmark: _Toc379957095][bookmark: _Toc397507636][bookmark: _Toc397514538][bookmark: _Toc397514633]
2. [bookmark: _Toc342004135][bookmark: _Toc342004618][bookmark: _Toc342004659][bookmark: _Toc342030863][bookmark: _Toc343538361][bookmark: _Toc343538416][bookmark: _Toc343538544][bookmark: _Toc367199635][bookmark: _Toc372704138][bookmark: _Toc373869186][bookmark: _Toc373870307][bookmark: _Toc373871373][bookmark: _Toc373933430][bookmark: _Toc379787610][bookmark: _Toc379957096][bookmark: _Toc397507637][bookmark: _Toc397514539][bookmark: _Toc397514634]
3. [bookmark: _Toc342004136][bookmark: _Toc342004619][bookmark: _Toc342004660][bookmark: _Toc342030864][bookmark: _Toc343538362][bookmark: _Toc343538417][bookmark: _Toc343538545][bookmark: _Toc367199636][bookmark: _Toc372704139][bookmark: _Toc373869187][bookmark: _Toc373870308][bookmark: _Toc373871374][bookmark: _Toc373933431][bookmark: _Toc379787611][bookmark: _Toc379957097][bookmark: _Toc397507638][bookmark: _Toc397514540][bookmark: _Toc397514635]
3.1. [bookmark: _Toc397514636]Štruktúra projektu IT4KT Practices
Projekt sa skladá z dvoch hlavných adresárov:
· „Source Packages“ – obsahuje adresáre pre predmety, v ktorých je možné vytvárať XML súbory pre cvičenia, obrázok loga predmetu, pridávať zdroje pre cvičenia (dokumenty, obrázky, a pod.), či definovať štýly pre cvičenia. Pre každý predmet je vytvorený jeden adresár. Vzor vytvorených materiálov môžete vidieť v adresári predmetu Technológie Java (adresár tjava).
· „Other Sources“ – obsahuje všetko potrebné pre správne vygenerovanie Vašich HTML stránok.
· Ostatné adresáre sú konfiguračnými adresármi projektu.
Pre začatie práce s projektom si vyberte adresár vášho predmetu v zozname adresárov a rozbaľte ho pomocou „+“.
Ak nenájdete svoj predmet v zozname medzi adresármi, kontaktujte administrátora projektu, nevytvárajte nový adresár sami.
Vytváranie adresárov funguje klasicky ako v akomkoľvek prehliadači súborov: pravé kliknutie myšou na adresár, v kontextovom menu vybrať „New -> Folder”, zadať názov adresára a stlačiť klávesu Enter.
POZOR! Nové adresáre vytvárajte len v adresári svojho predmetu! Vytvorením adresárov alebo pridávaním súborov môžete narušiť štruktúru cudzieho predmetu!
[image: C:\build3.png]
3.2. [bookmark: _Toc397514637]Výber profilu predmetu, generovanie materiálov a spustenie
Pre správne generovanie materiálov pre predmet je potrebné vybrať si zo zoznamu profilov daný predmet. Je možné vybrať aj cudzí predmet za účelom inšpirácie.
[image: C:\build1.png]
Po každej zmene v projekte je potrebné projekt pregenerovať stlačením tlačidla „Clean and Build“ v hornej lište, aby sa prejavili zmeny v materiáloch.
[image: C:\build2.png]
Spustenie projektu je možné vykonať pomocou tlačidla „Run“ v hornej lište.
[image: C:\build2.png]

3.3. [bookmark: _Toc397514638]Použitie a konfigurácia novších verzii editora NetBeans
Pre prácu je možné použiť aj novšie verzie editora NetBeans. Stačí postupovať podľa všetkých krokov doteraz uvedeného návodu. Následne nainštalovať novšiu verziu editora, spustiť a v dialógu potvrdiť použitie rovnakých nastavení v novšej verzii. Ak sa v novšej verzii editora automaticky neotvorí projekt IT4KT Practices, otvorte ho ručne pomocou File -> Open Project… . Predvolené umiestnenie projektu na OS Windows verzie 7 a vyššie býva v adresári C:\Users\meno_pouzivatela\Documents\NetBeansProjects\.

Novšie verzie editor NetBeans ale kontrolujú syntax HTML súborov. Keďže tie naše sú generované a ich syntax nás nezaujíma, nie je pre nás takáto funkcionalita podstatná a naviac, editor spomaľuje. Je možné ju deaktivovať nasledovne:
· Pregenerujte svoj projekt pomocou tlačidla „Clean and Build“.
· Otvorte akýkoľvek vygenerovaný HTML súbor, napr. fjap\output\lecturer\01.html
· Počkajte, kým editor zobrazí chyby a kliknite na prvú červenú žiarovku v otvorenom HTML súbore. Vyberte možnosť „Disable HTML error checking for all files of the text/html mimetype“.
[image: ]
· Počkajte kým editor aktualizuje zobrazenie súborov.
[image: ]
· Po aktualizácii by mali všetky chybové hlásenia v HTML súboroch zmiznúť.
[image: ]			[image: ]
· Túto možnosť môžete v prípade potreby kedykoľvek navrátiť podobným spôsobom, otvorením akéhokoľvek HTML súboru, kliknutím na prvú žiarovku a vybratím možnosti „Enable HTML error checking for all files of the text/html mimetype“.
· 
			
1.1. [bookmark: _Toc397514639]Tvorba materiálov v editore
Tvorba materiálov prebieha prostredníctvom vytvárania XML súborov. Každý XML súbor reprezentuje jeden modul (jedna HTML stránka). Názvy XML súborov je potrebné zadávať číselne v tvare: „01.xml“, „02.xml“, ... , „13.xml“.
Pre začiatok je vhodné skopírovať pripravené xml súbory „01.xml“ a „02.xml“ z už existujúcej šablóny materiálov v predmete Technológie Java (adresár tjava) do vášho predmetu. 
Editor NetBeans ponúka možnosť automatického dopĺňania elementov pomocou klávesovej skratky Alt+Space kdekoľvek v texte. Objaví sa výber pre automatické dopĺňanie a dokumentácia k práve označenému elementu. Je možné vybrať si zo zoznamu pre automatické dopĺňanie a po stlačení klávesy Enter editor automaticky doplní potrebné značky.
[image: C:\build5.png]
V XML musí mať každý element (značky v zátvorkách <>) počiatočnú a koncovú značku. Počiatočná značka sa píše v tvare <znacka> a koncová v tvare </znacka>. Atribúty značiek sa píšu v úvodzovkách vo vnútri počiatočnej značky <znacka atribut=”hodnota atributu”>.
Do tela elementov (medzi počiatočnú a koncovú značku je možné vložiť ďalší obsah – ďalší element alebo text.
Elementy, ktoré sú z jazyka HTML je možné do XML súboru vkladať pomocou prefixu h:, napríklad: <h:br></h:br>.
Pre bližšie oboznámenie sa s jazykom XML je k dispozícii zdroj: Základy jazyka XML.
Po úprave xml súboru je možné automaticky skontrolovať správnosť pomocou kliknutia pravého tlačidla myši v texte a voľbou „Check XML“ v kontextovom menu.
[image: C:\build4.png]
Pre kontrolu výskytov nesprávnych elementov v module je potrebné kliknúť pravým tlačidlom myši v texte a v kontextovom menu zvoliť „Validate XML“.
[image: C:\build4.png]
Po spustení projektu výsledok vygenerovania nájdete v adresári „output“ v adresári vášho predmetu. Obsahuje dva hlavné adresáre:
· „student“ – materiály pre študentov
· „lecturer“ – materiály pre učiteľa
V oboch adresároch sa nachádzajú HTML súbory webových stránok modulov a zdrojové súbory pre tieto stránky. Po spustení projektu (“Run”) sa v prehliadači automaticky otvorí úvodná stránka pre študentov (“output/student/01.html”).
[image: ]
4. [bookmark: _Toc397514640]Publikovanie vytvorených materiálov v systéme moodle
Vygenerované materiály, ktoré odošlete na SVN pomocou príkazu „Commit“ sú umiestnené na http://it4kt.cnl.sk/c. Rovnako ako v projekte, aj tu existuje verzia cvičení pre študenta (student) a pre učiteľa (lecturer). Verzia študent v adresári predmetu nachádza v adresári student a verzia učiteľ v adresári lecturer. Aby ste mohli publikovať cvičenie, nájdite html súbor daného cvičenia v súborovom systéme v adresári študent, kliknite naň pravým tlačidlom myši a v kontextovom menu vyberte voľbu:
· „Copy link address“ v prehliadači Google Chrome a Opera
· „Copy link location“ v prehliadači Mozilla Firefox
· „Copy shortcut“ v prehliadači Internet Explorer
	[image: ]
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Obr. 1: Príklad skopírovania odkazu cvičenia 1 v prehliadačoch Google Chrome (naľavo) a Mozilla Firefox (napravo)
Pre publikovanie materiálov v systéme moodle sa prihláste (musíte mať prístup k svojmu predmetu v roli učiteľa a zapnutý mód úprav) a v danom predmete zvoľte pri zodpovedajúcom cvičení voľbu „Pridať zdroj... -> Odkaz na súbor alebo web stránku“.
[image: C:\moodle1.png]
Zobrazí sa dialóg pre pridanie internetového odkazu. 
Zadajte názov cvičenia do políčka „Meno“ , ktorý bude zobrazený ako odkaz v moodle a do políčka „Poloha“ vložte pomocou klávesovej skratky Ctrl+V skopírovaný odkaz na cvičenie.
[image: C:\moodle2.png]
Stlačte tlačidlo „Uložiť a návrat do kurzu“. Internetový odkaz s názvom, ktorý ste zadali by mal pribudnúť v zodpovedajúcom cvičení.
5. [bookmark: _Toc397514641]Štruktúra XML
[image: ]
Obr. 2: Štruktúra elementov v XML.
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3. [bookmark: _Toc341995459][bookmark: _Toc341998683][bookmark: _Toc341998938][bookmark: _Toc342004144][bookmark: _Toc342004627][bookmark: _Toc342004668][bookmark: _Toc342030872][bookmark: _Toc343538370][bookmark: _Toc343538425][bookmark: _Toc343538553][bookmark: _Toc367199644][bookmark: _Toc372704147][bookmark: _Toc373869195][bookmark: _Toc373870316][bookmark: _Toc373871382][bookmark: _Toc373933439][bookmark: _Toc379787619][bookmark: _Toc379957105][bookmark: _Toc397507647][bookmark: _Toc397514549][bookmark: _Toc397514644]
4. [bookmark: _Toc341995460][bookmark: _Toc341998684][bookmark: _Toc341998939][bookmark: _Toc342004145][bookmark: _Toc342004628][bookmark: _Toc342004669][bookmark: _Toc342030873][bookmark: _Toc343538371][bookmark: _Toc343538426][bookmark: _Toc343538554][bookmark: _Toc367199645][bookmark: _Toc372704148][bookmark: _Toc373869196][bookmark: _Toc373870317][bookmark: _Toc373871383][bookmark: _Toc373933440][bookmark: _Toc379787620][bookmark: _Toc379957106][bookmark: _Toc397507648][bookmark: _Toc397514550][bookmark: _Toc397514645]
5. [bookmark: _Toc341995461][bookmark: _Toc341998685][bookmark: _Toc341998940][bookmark: _Toc342004146][bookmark: _Toc342004629][bookmark: _Toc342004670][bookmark: _Toc342030874][bookmark: _Toc343538372][bookmark: _Toc343538427][bookmark: _Toc343538555][bookmark: _Toc367199646][bookmark: _Toc372704149][bookmark: _Toc373869197][bookmark: _Toc373870318][bookmark: _Toc373871384][bookmark: _Toc373933441][bookmark: _Toc379787621][bookmark: _Toc379957107][bookmark: _Toc397507649][bookmark: _Toc397514551][bookmark: _Toc397514646]
5.1. [bookmark: _Toc397514647]Element module
Element module je koreňovým elementom pre opis výučbovej jednotky (cvičenia).
Výučbová jednotka by mala predstavovať logicky súvisiaci celok. Pri prezenčnej forme štúdia je predpokladom, že táto jednotka nebude rozdelená na viac stretnutí. V študijnom predmete zvyčajne zodpovedá počet modulov počtu cvičení v rámci jedného predmetu (zvyčajne 13).
Každý modul má svoj jedinečný názov (element title), zoznam cieľov (element objective) a krokov (element step) pomocou ktorých sa tieto ciele napĺňajú.
5.2. [bookmark: _Toc397514648]Element title
Element title definuje názov modulu. Názov by mal byť stručný, no musí vystihovať obsahovú podstatu modulu.
5.3. [bookmark: _Toc397514649]Element objective
Element objective opisuje cieľ modulu. 
Modul musí mať vždy aspoň jeden špecifický cieľ. Ciele v rámci modulu ale aj v rámci predmetu musia byť konzistentné.
Každý definovaný cieľ musí byť pokrytý aspoň jedným krokom v rámci modulu (element step).
Ciele by mali vždy vyjadrovať nielen obsah ale aj úroveň (viac o taxonómii cieľov: Bloomova taxonómia).
Cieľ musí mať uvedený identifikátor pomocou atribútu id.
5.4. [bookmark: _Toc397514650]Element introduction
Element introduction opisuje východiská pre konkrétny modul.
Môžu to byť základné pojmy a definície, kľúčové fakty, odkazy na výučbové materiály (prednášky, skriptá, učebnice) a pod.
Cieľom tejto časti je uviesť študenta do problematiky, vrátane vysvetlenia súvislosti tohto modulu s kontextom predmetu (prednášky, semináre, skúšanie).
5.5. [bookmark: _Toc397514651]Element step
Element step definuje množinu súvisiacich úloh, ktoré vedú k napĺňaniu aspoň jedného cieľa.
Pomocou atribútu objective je možné uviesť zoznam medzerou oddelených cieľov, ktoré budú splnené týmto krokom.
Uvedením zoznamu cieľov v atribúte objective je možné docieliť funkčnosť referencií na jednotlivé kroky. Po kliknutí na akýkoľvek cieľ v zozname cieľov predmetu sa vysvietia všetky kroky, ktoré je potrebné splniť na dosiahnutie tohto cieľa svetlo červenou farbou (viď obrázok).
[image: ]
Krok môže mať uvedený identifikátor pomocou atribútu id. Tento slúži pre referencovanie sa na konkrétny krok pomocou elementu link.
5.6. [bookmark: _Toc397514652]Element resource
Element resource slúži na opis zdroja, ktorý študenti používajú pri štúdiu modulu.
Zdrojom môže byť materiál na stiahnutie, kniha, internetový odkaz a podobne.
Zdroj môže mať uvedený identifikátor pomocou atribútu id. Tento slúži pre referencovanie sa na konkrétny zdroj pomocou elementu link.
5.7. [bookmark: _Toc397514653]Element additional
Element additional opisuje časti, ktoré sú pripravené nad základný rámec modulu (cvičenia).
Môžu to byť doplňujúce úlohy (element task) alebo doplňujúce zdroje (element resource). Vďaka tomuto členeniu je možné pripraviť domáce úlohy, resp. úlohy pre aktívnych študentov.
Doplňujúce úlohy sú voliteľné, ale každý študent by mal splniť minimálne tie úlohy, ktoré nie sú uvedené v tejto doplňujúcej časti.
5.8. [bookmark: _Toc397514654]Element task
Element task opisuje práve jednu úlohu, ktorú majú študenti vyriešiť.
Úloha by mala byť formulovaná tak, aby bola pochopiteľná a vyriešiteľná samostatne bez širšieho kontextu.
Úloha by mala mať správne riešenie a malo by byť možné overiť, či študent úlohu vyriešil alebo nevyriešil.
Úloha môže mať uvedený identifikátor pomocou atribútu id. Tento slúži pre referencovanie sa na konkrétnu úlohu pomocou elementu link.
5.9. [bookmark: _Toc397514655]Element comment
Element comment obsahuje doplňujúci komentár ku riešenému kroku alebo úlohe.
Komentáre by mali študentovi poskytovať dodatočné informácie k riešeniu problému, ktoré v prípade potreby študent môže použiť.
Komentár by nemal obsahovať podstatné poznámky, bez ktorých nie je možné úlohu správne vyriešiť.
Aj bez komentárov by mal ostať text modulu plnohodnotný, zvýšiť by sa mala akurát náročnosť nájdenia riešení, keďže študenta na riešenie menej navádzame.
V budúcnosti predpokladáme dynamické zobrazovanie komentárov na základe úspešnosti/neúspešnosti riešenia.
5.10. [bookmark: _Toc397514656]Elementy solution a result
Element solution opisuje správne riešenie úlohy. Riešenie by malo byť vnorené v úlohe. Nemusí byť poskytnuté ku každej úlohe.
Pre element result platí to isté, čo pre element solution, jediný rozdiel je v sémantike. Sémantický rozdiel medzi solution a result je nasledovný:
· solution – riešenie je procedurálne, vyžaduje opis postupu riešenia problému. Opis bude „Riešenie:“.
· result – riešenie bude typu „výsledok“, používa sa pre matematické úlohy alebo úlohy, ktoré neobsahujú opis postupu riešenia problému. Opis bude „Výsledok:“
Poznámka: Úloha môže mať aj postup riešenia aj výsledok.
Tip: ak sa element <solution> alebo <result> vnorí do bloku <lecturer>, bude riešenie viditeľné len pre učiteľa.
Dobrovoľné atribúty elementov solution a result sú:
· hidden – prepínač pre skryté riešenie
Atribút hidden
Atribút hidden slúži ako prepínač grafického zobrazenia riešenia, kedy je možné nastaviť riešenie alebo výsledok ako skrytý. Je možné zadať jednu z nasledovných hodnôt (pričom predvolená hodnota je false):
· false – riešenie bude zobrazené vždy
· true – riešenie bude skryté v prípade prvého zobrazenia stránky a zobrazí sa po slačení tlačidla „Zobraziť riešenie“ (resp. „Zobraziť výsledok“ pri type výsledok).
Príklad pridania riešenia alebo výsledku úlohy:
	<task>
		Zmeňte farbu písma tohto riadka.
<solution>
       Kliknite na tlačidlo „Farba písma“.
   </solution>
	</task>

<task>
		3+4=?
<result hidden=”true”>
       7
   </result>
	</task>
Výsledok:
[image: ]
Obr.: Naľavo príklad klasickej úlohy a úlohy typu výsledok s možnosťou zobrazenia/skrytia, napravo úloha po kliknutí na tlačidlo „Zobraziť výsledok“. Po opätovnom kliknutí na tlačidlo „Zobraziť výsledok“ bude výsledok schovaný.

Použitie postupu riešenia aj výsledku v jednej úlohe:
<task>
		Vyrátajte sústavu rovníc: 
		3x + 2y = 15
		10x – 15y = -5
		<solution>
			... postup riešenia ..
		</solution>
<result hidden=”true”>
   		... výsledok ...
   </result>
	</task>

5.11. [bookmark: _Toc343536416][bookmark: _Toc397514657][bookmark: _Toc343518060][bookmark: _Toc343536349][bookmark: _Toc343536417][bookmark: _Toc343538384][bookmark: _Toc343538439][bookmark: _Toc343538567][bookmark: _Toc367199658]Ďalšie elementy
[bookmark: _Toc343536418][bookmark: _Toc397514658]Element figure
Element figure zaobaľuje centrovaný obrázok s názvom.
Element môže obsahovať buď preformátovaný text (html pre), respektíve element image. Môže obsahovať textový opis obrázku, ktorý sa vkladá pomocou značky caption.

Príklad pridania obrázku:
<figure>
       <image>ast_uzly.png</image>
       <caption>
           Abstraktný syntaktický strom s označením listových 
uzlov.
       </caption>
   </figure>
Výsledok:
[image: ]
Obr.: Abstraktný syntaktický strom s označením listových uzlov

Na obrázok je možné nastaviť veľkosť obrázka pomocou atribútu scale. Príklad:
<image scale="50%">prechodovy-diagram.png</image>

[bookmark: _Toc343536419][bookmark: _Toc397514659]Element image
Element image slúži na vloženie obrázku do modulu. Obrázok bude zobrazený priamo na mieste vloženia.
Odporúčame vložiť element image do elementu figure, ktorý umožňuje pridať k obrázku aj textový popis.
Tento element je analógia elementu img z HTML.

[bookmark: _Toc343536420][bookmark: _Toc397514660]Element table
Element table zaobaľuje centrovanú tabuľku s popisom. Element môže obsahovať riadky (elementy row) a v nich sa môžu nachádzať stĺpce (col).
Tabuľka môže obsahovať aj hlavičkový riadok - element header.

Príklad pridania tabuľky:
<table>
    <caption>Toto je tabulka</caption>
    <header>
        <col>Meno</col>
        <col>Priezvisko</col>
        <col>Vek</col>
    </header>
    <row>
        <col>John</col>
        <col>Snow</col>
        <col>28</col>
    </row>
    <row>
        <col>Mike</col>
        <col>Shinoda</col>
        <col>30</col>
    </row>
    <row>
        <col>Peter</col>
        <col>Parker</col>
        <col>25</col>
    </row>
</table>
Výsledok:
[image: ]
Element table slúži ako zjednodušená verzia tabuľky pre neprogramátorov. Pre vytvorenie tabuľky je ale samozrejme možné použiť aj klasické html elementy <h:table>, <h:td>, <h:tr>, <h:th> a pod (viď kapitola Použitie HTML elementov).

[bookmark: _Ref373851500][bookmark: _Toc343536421][bookmark: _Toc397514661]Element math
Element math slúži na zápis matematických vzorcov vo formáte Tex, Latex, MathML, AsciiMath.
Dobrovoľné atribúty elementu math sú:
· display – prepínač grafického zobrazenia vzorca
· type – prepínač formátu zápisu vzorcov
Atribút display
Atribút display slúži ako prepínač grafického zobrazenia vzorca. Je možné zadať jednu  z nasledovných hodnôt (pričom predvolená hodnota je inline):
· block – zobrazenie vzorca v samostatnom boku.
· inline – zobrazenie vzorca priamo v texte.
Atribút type
Atribút type slúži ako prepínač formátu zápisu vzorcov. Je možné zadať jednu z nasledovných  hodnôt (pričom predvolená hodnota je Tex):
· Tex – pre zápis vzorcov vo formáte Tex.
· MathML – pre zápis vzorcov vo formáte MathML.
· AsciiMath – pre zápis vzorcov vo formáte AsciiMath.
Príklad použitia elementu math:
<step>
Toto: <math>x^2</math> je vzorec v texte.
<task>
Toto: <math display="block">x = {-b \pm \sqrt{b^2-4ac} \over 2a}</math> je vzorec v bloku.
</task>
</step>
Vzorový príklad je možné vidieť v prvom cvičení predmetu NM.

[bookmark: _Toc397514662]Element code
Element code slúži na zápis zdrojového kódu v rôznych programovacích jazykoch. Element umožňuje farebné zvýrazňovanie niektorých prvkov kódu.
Dobrovoľné atribúty elementu code sú:
· display – prepínač zobrazenia kódu,
· lang – označenie programovacieho jazyka pre zvýrazňovanie syntaxe.

Atribút display
Atribút display slúži ako prepínač zobrazenia kódu v samostatnom bloku alebo v texte. Je možné zadať jednu z nasledujúcich hodnôt (predvolená hodnota je inline):
· [bookmark: __DdeLink__1_1748820567]inline – zobrazenie kódu priamo v texte (použije sa neproporcionálne písmo),
· block – zobrazenie kódu v samostatnom boku (použije sa neproporcionálne písmo a zachovajú sa medzery a rozdeľovače riadkov).
Atribút lang
Atribút lang slúži na označenie programovacieho jazyka pre zvýrazňovanie syntaxe. Je to nepovinný atribút, ak sa nepoužije, nebude použité žiadne zvýrazňovanie syntaxe v texte. Je možne ho použiť iba pri zobrazení do bloku. Podporované hodnoty atribútu sú: bash, cpp (pre C++), cs (pre C#), css, diff, http, ini, java, javascript, json, haskell, matlab, perl, php, python, ruby, sql, xml (tiež pre HTML).
Na zvýrazňovanie sa používa program highlight.js: http://highlightjs.org/.

[bookmark: _Toc397514663]Element link
Element link umožňuje zapísať odkaz na webový zdroj vo forme URL (absolutne alebo relatívne URL).  Tento element je analógiou elementu a z HTML.
Dobrovoľné atribúty elementu link sú:
· href – url stránky, ktorá sa má zobraziť po kliknutí na odkaz,
· section – špecifikácia id elementu, na ktorý sa má stránka nastaviť po kliknutí na odkaz.

Atribút href
V pripade, že je použitý atribút href, jeho obsah sa interpretuje ako URL a text v elemente ako čitateľná forma pre človeka. V pripade, že href atribút nie je uvedený, samotný obsah elementu predstavuje URL, ktoré je zobrazené aj čitateľovi.
Príklady:
<link href="04.html">4. týždeň</link>
<link>http://en.wikipedia.org/</link>
Výsledok:
[image: ]
[image: ]
Atribút section
Ak sa použije atribút section, je možné v ňom použiť id objektu v module (je možné využiť elementy HTML kódu) a využiť ho na referovanie sa vo vnútri html stránky.
Na to, aby bolo možné sa odkazovať na sekciu na stránke, musí daný element mať nastavený atribút id. Takto si môžete definovať vlastné návestie v rámci vášho HTML kódu. Dbajte však na to, aby v rámci jedného cvičenia bola hodnota id jedinečná. Príklad:
<h:ul id="moj_odrazkovy_zoznam">
<h:li>
Entity 
</h:li>
	...
</h:ul>
Pri použití elementu link stačí použiť hodnotu id ako hodnotu atribútu section v elemente link:
<link href="01.html" section="moj_odrazkovy_zoznam">
Odkaz na odrážkový zoznam v prvom cvičení
</link>

Ak sa chcete odkazovať na predvolený element v rámci modulu, napríklad task, step, objective, resource a pod., potom je potrebné na začiatok tohto elementu vložiť neviditeľnú html značku s id, napr.:
<step>
<h:p id="odkaz_na_krok"/>
Obsah kroku…
</step>
Následné použitie elementu link:
<link href="01.html" section="odkaz_na_krok">
Odkaz na krok v prvom cvičení
</link>

[bookmark: _Toc397514664]Element quiz
Element quiz slúži na vloženie interaktívneho kvízu do modulu. Je možné ho použiť iba vo vnútri elementu additional. Kvíz sa môže skladať z niekoľkých úrovní a každá úroveň obsahuje niekoľko otázok.
Element quiz musí obsahovať jeden element title s názvom kvízu a aspoň jeden element question. Element question sa musí obsahovať text otázky a jeden element answer so správnou odpoveďou.
Otázky je možné explicitne rozdeliť do úrovní ich vložením do elementov level. V tomto prípade, element quiz bude obsahovať niekoľko elementov level a v nich budú uvedené elementy question. V opačnom prípade budú otázky rozdelené do úrovni automaticky, pričom každá úroveň bude obsahovať maximálne tri otázky.
Štruktúra elementov je teda takáto (znak „+“ označuje možnosť opakovania elementu 1-n krát):
· quiz
· title
· level +
· question +
· answer
Alebo zjednodušene:
· quiz
· title
· question +
· answer

Príklad definície kvízu (bez použitia elementu level):
<quiz> 
    <title>Názov kvízu</title> 
    <question> 
        Text otázky.
        <answer>Očakávaná správna odpoveď</answer> 
    </question>
     		. . . ďalšie otázky . . .
</quiz> 

Príklad definície kvízu (s použitím elementu level):
<quiz>
    <title>Názov kvízu</title>
    <level>
        <question>
            <text>Text otázky.</text>
            <answer>Očakávaná správna odpoveď</answer>
        </question>
       		    . . . ďalšie otázky . . .
    </level>
    	      . . . ďalšie úrovne level . . .
</quiz>

Kvíz má rozdielnu podobu vo verzii pre študenta a pre učiteľa. Pre učiteľa je zobrazený prehľad všetkých otázok a odpovedí. Pre študenta je zobrazený interaktívny kvíz, v ktorom je možné prejsť na ďalšiu úroveň až po zodpovedaní všetkých otázok z aktuálnej úrovne. Po úspešnom vyriešení kvízu má študent možnosť zadať svoje meno, ktoré bude zaznamenané v zozname úspešných riešiteľov.
Poznámka: Zmeny kvízu sa prejavia až po tom, čo bude študijný modul zaznamenaný na serveri (s prípadným niekoľko minútovým oneskorením). Preto počas vytvárania kvízu v prostredí NetBeans nie je možné vyskúšať aktuálnu verziu interaktívneho kvízu (vo verzii pre študentov). Keďže je potrebná spolupráca s externou službou pracujúcou na serveri, pri náhľade bude zobrazená len posledná zaznamenaná verzia kvízu. Aktuálny náhľad otázok je možné pozrieť iba vo verzii pre učiteľov.

[bookmark: _Ref372703465]
5.12. [bookmark: _Toc397514665]Použitie HTML elementov
Pridávanie akýchkoľvek HTML elementov je možné použitím prefixu h: pred značkou elementu. Príklady:

Príklad (formátovanie):
<h:b>Syntaxou riadený interpretátor</h:b> je programový nástroj, ktorý vyhodnocuje <h:i>význam (sémantiku)</h:i> postupnosti príkazov, ktoré <h:u>dostane na vstupe</h:u>.
Výsledok:
[image: ]

Príklad (odrážkový zoznam):
Oboznámte sa s pokynmi pre prípravu na test a spracovanie zadaní:
<h:ul>
<h:li>
<link href="04.html">Test A</link>
</h:li>
<h:li>
Zadanie B (<link href="07.html">pokyny</link>)
</h:li>
<h:li>
Zadanie C (<link href="11.html">pokyny</link>)
</h:li>
</h:ul>

Výsledok:
[image: ]

Podobným spôsobom je možné pridávať akýkoľvek HTML element. Je potrebné ale dávať pozor, aby každý element mal koncovú značku.
Viac o HTML na: http://videotutorialy.sk/category/html/ a http://www.w3schools.com/html/default.asp.

6. [bookmark: _Toc343536422][bookmark: _Toc397514666]Pokročilá práca s projektom
Projekt generátora materiálov má preddefinovaný formát HTML stránky, ktorý môžete používať. Ak ale chcete tento formát rozšíriť alebo zmeniť, je to možné urobiť v adresári vášho predmetu pridaním CSS štýlov, XSLT šablón alebo definovaním nových XML elementov prostredníctvom XSD schémy.
1. [bookmark: _Toc342030886][bookmark: _Toc343517970][bookmark: _Toc343518066][bookmark: _Toc343536355][bookmark: _Toc343536423][bookmark: _Toc343538390][bookmark: _Toc343538445][bookmark: _Toc343538573][bookmark: _Toc367199665][bookmark: _Toc372704168][bookmark: _Toc373869216][bookmark: _Toc373870337][bookmark: _Toc373871403][bookmark: _Toc373933460][bookmark: _Toc379787641][bookmark: _Toc379957127][bookmark: _Toc397507670][bookmark: _Toc343536430][bookmark: _Toc397514572][bookmark: _Toc397514667]
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6.1. [bookmark: _Toc397514673]Zmena formy
Forma je v projekte definovaná pomocou CSS štýlov a pomocou XSLT transformačnej šablóny.
[bookmark: _Toc343536431][bookmark: _Toc397514674]Zmena CSS štýlov
V adresári „Other sources/src/main/resources/style“ sa nachádzajú predvolené CSS štýly a logá. 
Pre úpravu existujúcich štýlov skopírujte súbor „custom.css“ do adresára „style“ v adresári vášho predmetu. Do tohto CSS súboru môžete nastaviť vlastné CSS štýly. 
Štýly vytvorené v tomto CSS súbore prepíšu predvolené štýly.
[image: ]

[bookmark: _Toc343536432][bookmark: _Toc397514675]Zmena XSLT šablón
Štruktúru stránky (transformačné pravidlá) je možné meniť pomocou XSLT šablóny.
[bookmark: _Toc343536433][bookmark: _Toc397514676]Zmena CSS štýlov
V adresári „Other sources/src/main/resources/transform/“ sa nachádzajú predvolené CSS štýly a logá. 
Pre úpravu existujúcich štýlov skopírujte súbor „custom.xsl“ do adresára „transform“ v adresári vášho predmetu. Do tohto XSL súboru môžete vkladať vlastné transformačné pravidlá. 
Transformačné pravidlá vytvorené v tomto XSL súbore prepíšu predvolené transformačné pravidlá. 
[image: ]

6.2. [bookmark: _Toc343536434][bookmark: _Toc397514677]Zmena štruktúry
Pridávanie nových XML elementov je možné vytvorením nových XSD schém.
XSD schémy je možné vytvárať v adresári schema v adresári vášho predmetu.
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V novej schéme je potrebné vytvoriť vlastný priestor mien a nastaviť ho ako cieľový pre túto schému, napr.:
<xsd:schema xmlns:xsd="http://www.w3.org/2001/XMLSchema"
            targetNamespace="http://kpi.fei.tuke.sk/practices/fjap"
            xmlns:f="http://kpi.fei.tuke.sk/practices/fjap"
            xmlns:p="http://kpi.fei.tuke.sk/practices"
            xmlns:h="http://www.w3.org/1999/xhtml"
            elementFormDefault="qualified">
Tento priestor mien budete používať ako prefix pre svoje nové elementy v xml súboroch. Ak chcete použiť existujúce XSD typy a elementy, je potrebné importovať ich pomocou elementu import na začiatku vášho xsd súboru hneď po deklarácii priestorov mien:
    <xsd:import namespace=http://www.w3.org/1999/xhtml
schemaLocation="xhtml1-strict.xsd"/>
    <xsd:import namespace=http://kpi.fei.tuke.sk/practices
schemaLocation="practices.xsd"/>
Potom je možné definovať nové elementy a typy, napr.:
<xsd:element name="warning">
    <xsd:complexType mixed="true">
        <xsd:group ref="p:anyHTMLExtendedGroup"/>
    </xsd:complexType>
</xsd:element>
V xml súboroch je takýto element možné potom použiť v tvare:
<step objectives="id_ciel3">
    <f:warning>
 	        Odložte si príklad pre ďalšie cvičenia.
    </f:warning>
</step>
Je však nutné do xml súboru vložiť na do hlavičky váš vytvorený priestor mien:
<module  xmlns:xsi='http://www.w3.org/2001/XMLSchema-instance'
   xmlns='http://kpi.fei.tuke.sk/practices'
   xmlns:f='http://kpi.fei.tuke.sk/practices/fjap'
   xmlns:h='http://www.w3.org/1999/xhtml'
   xsi:schemaLocation='
http://kpi.fei.tuke.sk/practices ../../resources/schema/practices.xsd 
http://www.w3.org/1999/xhtml ../../resources/schema/xhtml1-strict.xsd
http://kpi.fei.tuke.sk/practices/fjap schema/fjap.xsd'>

Príklad vytvorenia vlastnej xsd schémy, vlastných transformačných pravidiel (alebo rozšírenia/upravenia existujúcich) a vlastných štýlov je možné vidieť v adresári predmetu fjap v adresároch schema, transform/xslt a style.
6.3. [bookmark: _Toc397514678]Zaheslovanie prístupu k učiteľským materiálom
Kvoli jednoduchosti práce s generátorom materiálov a kontroly vygenerovaných mateirálov, zaheslovanie prístupu k učiteľským materiálom odporúčame vykonať až po dokončení materiálov vtedy, keď už je potrebné poskytnúť cvičenia študentom. Zaheslovanie prístupu je možné tak, že do adresára output/lecturer vložíme súbory .htaccess a .htpasswd.
Najprv je ale potrebné nastaviť Netbeans tak, aby boli tieto dva súbory viditeľné. To je možné nasledovne:
V menu kliknite na: Tools->Options->Miscellaneous->Files
V textovom poli zmeňte zápis tak, aby akceptoval aj htpasswd súbory (doplňte text “htpasswd|”):
^(CVS|SCCS|vssver.?\.scc|#.*#|%.*%|_svn)$|~$|^\.(?!htpasswd|htaccess$).*$
Potvrďte tlačidlom OK. Teraz by ste mali vidieť súbory vytvorené v nasledujúcom postupe.

Postup pre vytvorenie súborov .htacess a .htpasswd:
Najprv si vytvoríme oba súbory. V prostredí Netbeans je možné nové súbory v adresári lecturer vytvárať nasledovne: pravý klik na adresár lecturer -> New -> Other... -> v okne vyberte Other -> Empty File -> Next -> zadajte názov „.htpasswd“ alebo „.htaccess“ -> Finish.
Vytvorte nový súbor s názvom .htaccess a vložte do neho nasledujúci obsah:
AuthUserFile /opt/it4kt/www/c/nazov_adr_predmetu/lecturer/.htpasswd
AuthGroupFile /dev/null
AuthName "The Secret Page"
AuthType Basic

<Limit GET POST>
require valid-user
</Limit>
pričom text nazov_adr_predmetu je potrebné nahradiť za názov adresára príslušného predmetu, (napr. fjap). Uložte a zatvorte súbor .htaccess.
Ďalej vytvorte nový súbor .htpasswd. Obsah súboru .htpasswd je možné vytvoriť pomocou tohto nástroja, kde do políčka “Username” napíšte login a do políčka “Password” zadajte heslo pre predmet (odporúčame písmená aj čísla, napr. fjapko2013). Po stlačení tlačidla “Create .htpasswd file” sa zobrazí vygenerovaný obsah, mal by to byť jeden riadok v tvare login:$zakryptovane_heslo.
Tento riadok skopírujte do novo vytvoreného súboru .htpasswd.
Môže sa stať, že po nakopírovaní bude v adresárovej štruktúre v nástroji Netbeans vidno súbor .htpassword sivou farbou. Chyba je v SVN, ktorého predvoleným nastavením je ignorovanie tohto súboru. Pre odignorovanie je potrebné kliknúť na .htpasswd pravým tlačidlom -> Subversion -> Unignore.
V nasledujúcom kroku je potrebné presunúť tieto dva súbory na server, aby bolo možné zamedziť prístupu k učiteľským materiálom. To urobíme prostredníctvom funkcie Commit nad adresárom projektu podľa návodu v kapitole Odoslanie materiálov predmetu na SVN.
UPOZORNENIE: Odteraz už je možné využívať LEN tlačidlo Build. Ak sa pomýlite a stlačíte namiesto neho Clean & Build, obsah adresára bude premazaný a oba súbory pre zaheslovanie budete musiet nakopírovať znova. To isté sa stane, ak omylom zmažete adresár output/lecturer. Preto odporúčame oba súbory si zálohovať.
Po tomto je dobré overiť, či všetko prebehlo správne. Upload materiálov sa udeje až po niekoľkých sekundách. Ak si teraz zobrazíte adresár svojho predmetu v prehliadači (napr. http://it4kt.cnl.sk/c/fjap/) a znovu načítate obsah (Reload), adresár lecturer už nebude viditeľný. Po zadaní adresy pre tento adresár do prehliadača (napr. http://it4kt.cnl.sk/c/fjap/lecturer) už bude prehliadač vyžadovať heslo pre prístup do adresára. To isté platí aj pre zobrazenie akejkoľvek stránky z učiteľských materiálov. Overte si, že vami zadané meno a heslo korektne umožní prístup k učiteľským materiálom.
7. [bookmark: _Toc397514679]Vygenerované súbory
Všetky vygenerované súbory sa nachádzajú v adresári output vášho predmetu. Tento adresár obsahuje nasledujúce podadresáre:
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· student – obsahuje html stránky a zdroje, ktoré sú viditeľné verejne, pre študentov aj učiteľov.
· lecturer – obsahuje html stránky a zdroje, ktoré by mali byť viditeľné len pre učiteľa.
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Spoločné adresáre a súbory pre učiteľa aj pre študenta sú:
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· resources – adresár so zdrojmi pre projekt
· style – adresár pre štýly html stránok
· 01-13.html – súbory html stránok, pre každé cvičenie jeden súbor
Adresár student naviac obsahuje aj tri ďalšie súbory:
· math.html – zbierka všetkých matematických vzorcov použitých vo všetkých cvičeniach predmetu. V zozname vzorcov sa zobrazia iba tie vzorce, ktoré sú v xml súboroch zapísané v bloku <math></math>. Tento výstup je možné použiť ako zbierku vzorcov pre študentov na naučenie resp. ako oficiálny ťahák pri testoch a skúškach.
· objectives.html  - zbierka všetkých cieľov vo všetkých cvičeniach. Tento výstup je možné využiť napríklad pri tvorbe úvodnej stránky k predmetu.
· tasks.html – zbierka všetkých riešených aj neriešených úloh vo všetkých cvičeniach (okrem doplňujúcich). Tento výstup je možné použiť ako zbierku príkladov alebo úloh pre študentov.
Predvolené nastavenie je zatiaľ také, že pre tieto tri súbory v projekte neexistuje odkaz a je potrebné ho pridať ručne podľa potreby. Každý zo súborov je možné zobraziť v prehliadači. Príklad:
http://it4kt.cnl.sk/c/nm/student/math.html
http://it4kt.cnl.sk/c/fjap/student/objectives.html
http://it4kt.cnl.sk/c/fjap/student/tasks.html
8. [bookmark: _Toc397514685]Úvodná stránka k predmetu
V každom predmete sa nachádza súbor info.xml, ktorý reprezentuje úvodnú stránku k predmetu. Tento súbor má nasledujúcu štruktúru:
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Obr. 3: Štruktúra elementov v súboroch info.xml
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8.1. [bookmark: _Toc397514694]Element subjectInfo
Element subjectInfo je koreňovým elementom pre opis informácií k predmetu.
Opis predmetu by mal obsahovať všeobecné informácie o predmete a cvičeniach. Môže mať svoj názov (ak nie je, bude automaticky generovaný), zoznam cieľov, doplňujúce informácie, podmienky pre získanie zápočtu, zoznam prednášajúcich a cvičiacich a zoznam zdrojov k predmetu.
8.2. [bookmark: _Toc397514695]Element title
Element title definuje názov stránky obsahujúcej informácie o predmete. Ak nie je zadaný, bude automaticky vygenerovaný názov v tvare „Informácie o predmete“. Môže sa uviesť aj názov „Podmienky pre získanie zápočtu“.
8.3. [bookmark: _Toc397514696]Element objective
Element objective opisuje všeobecný cieľ predmetu. 
Každý predmet musí mať vždy aspoň jeden špecifický cieľ. Ciele v rámci predmetu musia byť konzistentné.
Ciele by nemali byť konkrétne, mali by opisovať všeobecné ciele predmetu, čo sa študent naučí a čo dosiahne na tomto predmete. Tieto ciele by mali byť rozložiteľné na čiastkové ciele, ktoré predstavujú ciele modulov.
Ciele by mali vždy vyjadrovať nielen obsah ale aj úroveň (viac o taxonómii cieľov: Bloomova taxonómia).
8.4. [bookmark: _Toc397514697]Element additionalInfo
Element additionalInfo opisuje prídavné informácie pre predmet.
Môže to byť napr. opis priebehu cvičení, kľúčové fakty a pod.
8.5. [bookmark: _Toc397514698]Element conditions
Element conditions definuje množinu podmienok pre získanie zápočtu z daného predmetu. Mal by opisovať bodové hodnotenie predmetu a typy zadaní, ktoré študent musí na cvičeniach počas semestra zvládnuť.
Pomocou atribútu generatePresenceConditions="true" je možné povoliť vygenerovanie dvoch základných podmienok: (i) „Ani jedna neospravedlnená neúčasť“ a (ii) „Maximálne 3 ospravedlnené neúčasti - spôsob náhrady určí cvičiaci“.
8.6. [bookmark: _Toc397514699]Element scores
Element scores slúži na určenie počtu bodov, ktoré sú podmienkou pre získanie zápočtu z cvičení.
Obsahuje dva pod-elementy max a min definujúce maximálnu a minimálnu bodovú hodnotu.
Príklad:
<scores>
            <max>30</max>
            <min>16</min>
        </scores>
8.7. [bookmark: _Toc397514700]Element assignments
Element assignments obsahuje zoznam zadaní, ktoré musí študent zvládnuť pre získanie zápočtu z cvičení.
8.8. [bookmark: _Toc397514701]Element assignment
Element assignment opisuje práve jedno zadanie, ktoré musí študent zvládnuť pre získanie zápočtu.
Element má tri nepovinné atribúty: 
· type – typ zadania
· maxPoints – maximálny možný počet bodov za zadanie
· week – týždeň, ktorý je posledným pre odovzdanie zadania
Atribút type
Atribút type slúži na určenie typu zadania. Povolené hodnoty atribútu sú: test (pre test), program (pre programovacie zadanie), document (pre dokument – napr. referát), activity (pre body za aktivitu), presentation (pre prezentáciu), undefined (pre žiadny typ). Predvolená hodnota atribútu je undefined.
Ak nie je zadaný atribút type, text elementu assignment by mal vysvetľovať typ zadania a účel zadania.
Atribút maxPoints
Atribút maxPoints slúži na zadanie číselnej hodnoty reprezentujúcej maximálny možný počet za dané zadanie. Tento atribút je povinný.
Atribút week
Atribút week slúži na zadanie číselnej hodnoty reprezentujúcej posledný termín pre odovzdanie zadania. Ak nie je zadaný, je potrebné termín zadať v texte elementu assignment.
Príklad použitia elementu assignment:
   <assignment type="test" maxPoints="10" week="4">
                Test A
            </assignment>
Vzorové príklady je možné vidieť v šablóne súboru info.xml a v predmete FJaP.

8.9. [bookmark: _Toc397514702]Element resource
Element resource slúži na opis zdroja, ktorý študenti používajú pri štúdiu predmetu.
Zdrojom môže byť materiál na stiahnutie, kniha, internetový odkaz a podobne.
Zoznam zdrojov na úvodnej stránke by nemal obsahovať všetky zdroje z modulov, ale len najdôležitejšie, všeobecné zdroje týkajúce sa predmetu a cvičení všeobecne, ktoré je možné použiť pri štúdiu počas celého semestra.

8.10. [bookmark: _Toc397514703]Úvodná stránka v prehliadači
Úvodnú stránku je možné v internetovom prehliadači zobraziť kliknutím na Cvičenia: v hornom menu.
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9. [bookmark: _Toc397514704]Prídavný modul pre prácu s XML modulmi
Prídavný modul pre prácu s modulmi umožňuje zjednodušenie a urýchlenie vytvárania materiálov pre cvičenia. Poskytuje jednoduchú, ľahko použiteľnú paletu elementov, ktoré je možné jednoduchým presunutím myši vložiť do XML súboru modulu.
Prídavný modul je možné si stiahnuť z http://bodrog.fei.tuke.sk/it4kt/services/e1/2013-12-03-sk-tuke-it4kt-plugin-v1.0.nbm.
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4. [bookmark: _Toc379787682][bookmark: _Toc379957168][bookmark: _Toc397507711][bookmark: _Toc397514613][bookmark: _Toc397514708]
5. [bookmark: _Toc379787683][bookmark: _Toc379957169][bookmark: _Toc397507712][bookmark: _Toc397514614][bookmark: _Toc397514709]
6. [bookmark: _Toc379787684][bookmark: _Toc379957170][bookmark: _Toc397507713][bookmark: _Toc397514615][bookmark: _Toc397514710]
7. [bookmark: _Toc379787685][bookmark: _Toc379957171][bookmark: _Toc397507714][bookmark: _Toc397514616][bookmark: _Toc397514711]
8. [bookmark: _Toc379787686][bookmark: _Toc379957172][bookmark: _Toc397507715][bookmark: _Toc397514617][bookmark: _Toc397514712]
9. [bookmark: _Toc379787687][bookmark: _Toc379957173][bookmark: _Toc397507716][bookmark: _Toc397514618][bookmark: _Toc397514713]
9.1. [bookmark: _Toc397514714]Návod na inštaláciu
Stiahnite si prídavný modul z vyššie uvedeného odkazu. V hlavnom menu v nástroji Netbeans kliknite na Tools->Plugins.
[image: ] 
V novo otvorenom okne Plugins vyberte záložku Downloaded.
[image: ]
V tejto záložke kliknite na Add Plugins...
[image: ]
V dialógu vyberte súbor prídavného modulu, ktorí ste stiahli z odkazu a kliknite na Open.
[image: ]
V okne Plugins by sa v zozname stiahnutých prídavných modulov mala objaviť zaškrtnutá položka IT4KTPlugin. kliknite na tlačidlo Install.
[image: ]
Zobrazí sa inštalátor prídavného modulu. Kliknite na tlačidlo Next.
[image: ]
Potvrďte, že súhlasíte s pravidlami zaškrtnutím zaškrtávacieho tlačidla a kliknite na tlačidlo Install.
[image: ]
Zobrazí sa okno, ktoré Vás upozorní na to, že obsah, ktorý inštalujete, nie je oficiálne overený. Kliknite na tlačidlo Continue.
[image: ]
Po úspešnej inštalácii sa zobrazí správa o výsledku inštalácie. Kliknite na tlačidlo Finish.
[image: ]
Pred použitím skontrolujte, či bol prídavný modul naozaj pridaný do zoznamu nainštalovaných modulov kliknutím na záložku Installed. Následne zatvorte okno tlačidlom Close.
[image: ]
9.2. [bookmark: _Toc397514715]Návod na použitie
Po nainštalovaní prídavného modulu je možné v projekte ihneď vidieť zmenu – editor rozpoznáva jednotlivé typy xml súborov.
[image: ]
Po otvorení napr. súboru 01.xml sa na pravej strane editora objaví paleta elementov. Ak sa paleta nezobrazila, je možné ju otvoriť pomocou kliknutia na položky Window->Palette v hlavnom menu editora. Podobným spôsobom je možné zobraziť aj vlastnosti dokumentu pomocou kliknutia na položky Window->Properties v hlavnom menu editora.
[image: ]
Okno Properties (Vlastnosti) má informačný účel. Je v ňom možné vidieť základné informácie o module, ako je názov, počet cieľov, celkový počet krokov, celkový počet úloh a celkový počet prídavných úloh.
Okno Palette (Paleta) slúži na pridávanie jednotlivých typov elementov priamo do modulu.
[bookmark: _Toc397514716]Vloženie jednoduchého elementu pomocou palety
Návod na vloženie jednoduchého elementu do xml súboru (štýlom drag&drop):
1  Kliknite napr. na element Objective v palete, podržte tlačidlo myši
2  Presuňte tento element do súboru na miesto, kde chcete vložiť ďalší cieľ
3  Pustite tlačidlo myši
4  Text elementu sa automaticky vloží na určené miesto
5  Pri chybnom vložení je možné pre vrátenie zmeny stlačiť tlačidlo Späť [image: ] alebo použiť klávesovú skratku Ctrl+Z.
[image: ]
Zoznam jednoduchých elementov:
· Objective – vloží blok <objective> ... </objective>
· Step – vloží blok <step> ... </step>
· Task – vloží blok <task> ... </task>
· Resource – vloží blok <resource> ... </resource>
· Comment – vloží blok <comment> ... </comment>
· Lecturer – vloží blok <lecturer> ... </lecturer>
· New Line – vloží nový riadok
· Paragraph – vloží HTML paragraf
· Bold – tučné písmo
· Italic – šikmé písmo
· Underline – podčiarknuté písmo
· Math elementy – slúžia na vloženie matematických vzorcov pomocou \( \) a \[ \]
· Code – vloží blok <code> ... </code>
[bookmark: _Toc397514717]Vloženie parametrického elementu pomocou palety
Parametrické elementy sa vkladajú rovnako ako jednoduché elementy, ale po ich vložení sa zobrazí dialóg, ktorý umožňuje nastavenie parametrov.
Po zobrazení dialógu je možné nastaviť hodnoty, alebo nechať hodnoty prednastavené a jednoducho potvrdiť tlačidlom OK.
Zoznam parametrických elementov:
· Solution – vloží blok <solution> ... </solution>. Je možné nastaviť, či bude riešenie viditeľné alebo skryté (predvolené je skryté).
[image: ]
· Result – vloží blok <result> ... </result>. Funguje rovnako ako blok Solution, rozdiel je len sémantický (resp. v názve vložených značiek.
· [image: ]Link – vloží blok <link> ... </link>. Vloží odkaz na interný alebo externý zdroj. V prípade, že chceme vybrať zdroj z adresára resources v projekte, je možné použiť tlačidlo Browse. V prípade vloženia odkazu je potrebné prepnúť mód z Resource na URL. Text odkazu nie je povinné nastaviť, v tom prípade bude textom zdroj resp. URL.
[image: ]  
· Figure – vloží blok <figure> ... </figure>. Pre obrazok je možné nepovinne nastaviť popis obrázka (Caption), vybrať jeho zdroj pomocou tlačidla Browse... a nastaviť jeho veľkosť v percentách (Scale). Pre použitie tohto elementu je nutné, aby súbor s obrázkom bol v adresári resources.
[image: ]
· Table – vloží blok <table> ... </table>, teda tabuľku. Pre tabuľku je nepovinne možné nastaviť popis tabuľky (Caption), počet riadkov (Rows) a stĺpcov (Columns) a smerovanie hlavičky tabuľky (Table header) na: horizontálne, vertikálne a bez hlavičky.
[image: ]
· Unordered List – vloží blok <h:ul> ... </h:ul>, teda neusporiadaný zoznam. Pre zoznam je možné nastaviť počet položiek.
[image: ]
· Ordered List – vloží blok <h:ol> ... </h:ol>, teda usporiadaný zoznam. Funguje rovnako ako Unordered list: je možné nastaviť počet položiek.
· HTML Table – vloží HTML tabuľku, nastavenia sú rovnaké ako pri Table.
· IT4KT Math – vloží blok <math> ... </math>. Slúži ako alternatíva k \[ \] a \( \), pričom vzorce označené týmto blokom budú zaradené do vygenerovanej zbierky vzorcov. Pri výbere tohto elementu z palety je možné nastaviť typ matematického vzorca (viď kapitolu Element math).
[image: ]
[bookmark: _Toc397514718]Elementy palety súboru info.xml
Súbor info.xml predstavuje úvodné informácie k predmetu. Jeho štruktúra je odlišná od modulov, preto má samostatnú paletu.
[image: ]
Odlišné elementy na palete súboru info.xml sú nasledujúce:
· Assignment – vloží blok <assignment> ... </assignment> reprezentujúci zadanie alebo podmienku pre splnenie zápočtu. Je možné nastaviť text, typ zadania (test pre test, program pre programovacie zadanie, activity pre body za aktivitu, presentation pre nutnosť odprezentovania výsledkov práce, document pre dokument, none pre základný typ), maximálny počet bodov, ktorý je možné získať za dané zadanie a dobrovoľne týždeň, v ktorom študent musí zadanie najneskôr odovzdať.
[image: ]
· Presenter – vloží blok <presenter> ... </presenter> reprezentujúci informácie o prednášajúcom na prednáškach z daného predmetu. U prednášajúceho je možné nastaviť jeho meno, e-mailový kontakt a url na domovskú webovú stránku prednášajúceho.
[image: ]
· Instructor – vloží blok <instructor> ... </instructor> reprezentujúci informácie o cvičiacom na cvičeniach z daného predmetu. Nastavenia sú rovnaké ako pri elemente Presenter.
[bookmark: _Toc397514719]Vytváranie nových súborov pomocou prídavného modulu
Prídavný modul je implementovaný tak, aby poskytoval aj možnosť rýchleho vytvorenia prázdneho modulu alebo informácií k predmetu (info.xml).
Pre vytvorenie nového modulu kliknite pravým tlačidlom na adresár vášho predmetu a vyberte možnosť New -> Other...
[image: ]
V zozname kategórií vyberte kategóriu IT4KT a v zozname typov súborov vyberte Module.xml. Kliknite na tlačidlo Next.
[image: ]
Zadajte názov nového súboru a kliknite na tlačidlo Finish.
[image: ]

Vytvorí sa nový prázdny modul s predvytvorenou šablónou pre vpisovanie obsahu.
Podobným spôsobom je možné vytvoriť aj súbor info.xml. V zozname kategórií vyberte IT4KT, v zozname typov súbor vyberte SubjectInfo.xml a ako názov súboru uveďte napr. info. Vytvorí sa nový súbor info.xml s predvyplnenou šablónou pre vpisovanie obsahu.
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Uvod

Na tomto cviteni sa nautite pracovat s virtudinym strojom Computron VM. Computron je program emulujiici potitaé, kiory sa
bude pouivat ako cielové architekiira pri preklade programov na daliich cviéeniach V druhej polovici cvitenia sa
oboznémite s tedriou prekladatov a s prvou fazou prekladu - lexikalnou analyzou. Na zaklade ziskanych znalosti zviadnete
upravit kéd lexikéineho analyzatora pre podporu viastnych symbolov.
Postup vyznadené kroky, ktoré je potrebné splnit pre

dosiahnutie Kiknutého ciela

1. Prestudujte si navod a K virtudinemu stroju Computron VM

Uloha: Spustite virtuélny stroj Computron.

Poznamka: Pre spustenie pouZite prikaz.

3java -jar Computron VM.jar

Uloha: Natitajte do Computron VM predvytvoreny priklad.
Uloha: Co sa stane ak spustite program pomocou tiatidia "Run"?
2. Spustite prikiad so spravne vopred inicializovanymi registrami
Uloha: Zastavte beh prikiadu pomocou tiacidia "Run" a inicializujte register Begin na hodnotu 010.

Poznamka: Nastavenie hodndt registrov je mozné vykonat v sekcii "ODFC PROGRAMMING DEVICE™
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